


;& F DOS 6. 2

W MHER %E

RN sl o



(FR)FEF 158 5

-.,T - KA . e
LS

' W ke
ZRHDOS6 2 +

WLM HER HF

AR PCRE TR D G B A AR BN B AR A R HAR. 1994, BB XREFR
SRR RN B EERER B BR YR 1994, REHBEBEAFABHEMAFREH
RPREBHAE.

ABREMMEET F ¥ DOS FMMTIEE. RABTHEGRIEST R, B R %N A DOS
6.2 B MIIBE R LRI B W LT DOS6. 2 FHhk; M R4 4 T DOS 6. x 4 aY
ik ) R R R g

AT » BIED 65T
A5 S WA 1B R OR 2 RAL BOL BT D iR 35, ToAn 5 F A
BHE. -

HRE . ek R LR EEKRF RN, ER% 100084)
HERE - EEE

ENRIE . HaERFEnR)

RiTH: FEBEBEICERBRITR

A, 787X 1092 1/16 EN5K.20.75 F¥:517 TF
w1994 9 ASE IR 19944 9 A% 1 KEIRI

£, ISBN7-302-01561-9/TP « 649

¥(. 0001—8000

#r: 32.00 7

24 FH



W1
1.1
1.2
1.3
1.4

L F)
2.1
2.2
2.3
2.4
2.5

L KE
3.1

=R

DOS 6. 2 ﬂ?mmﬁtfi:éﬁ

Kﬁ:%mgﬁﬁ.
DoubleSpace fZHIBE L BF AN «ov wveeveerrvrasersrnsrenarssrnmnansnosssisansionnes

[ T = T == Iy
Ll
N U1 e W DN

. 4. %ﬁilﬁ‘
DOS 6.2 IRE
JEBR MS-DOS 6. 2 Yy JE 45 3 4
DOS 6. 2 ZERTHIHES

. 25

DOS 6. 2 ZEE 8 XL

E_R

DBLSPACE f# % 5% %%

DoubleSpace BIFTTHEE oovvevsersroreeertiniiiniiniiiiiiiiiniiintossnasnseccee
3.1.1 DBLSPACE.EXE ﬁ‘g‘iﬁﬁiﬁﬁ»’é‘iﬁﬁf? T T T TT R TSR R TP PP PP P PR PR
3.1.2 DoubleSpace {ffﬁlﬁ$ S T T R L
3.1.3 DoubleSpace +/NEJ%$---
3.1.4 MS-DOS 6. 2 #J DoubleSpace T HE secererrerrrrererorrcrrnccnicniainnne

3.1.5 MS-DOS 6.0 #J DoubleSpace &n{a] & & i}, DOS 6. 27

© X N A h h W N =

[ —
N O

-« 13
- 17

19

28

s 30

30
32
32
35



. 3.1.6 {# F§ DoubleSpace H‘Jﬂ_jﬁﬁiﬂﬁ’ tesesssssesssrerasscacrsserassrransacsscesacssss 36
3.2 DoubleSpace %ﬁﬁﬁfi& Ceterentesssasssencesnennasirtasaatrassarsesesessesasaasosescrares 3f
3.2.1 DoubleSpace Bﬁaﬁﬂ:ﬁgﬁ—t.. 36
3.2.3 DoubleSpace f‘ﬁ%tq%%@] T T R T - ¥4
3.2.4 DoubleSpace mﬁﬁg%wg 43
3.3 DoubleSpace &2 5 - cereenaredans T 1
3.3.1 %% DoubleSpace 2 JEHIE FI GABAL  voveeeeressessssrnesssnnnuininnnnee 46
3.3.2 fF4 R CVF 5 HOST_DRIVE? eteseessssssssonsenecccisunncinticinnices 48
3.3.3 DBLSPACE. INT fJF I oreeeerrerseserssssntntnusnescasscenonioniisesisinans 49
3.3.4 FHUSHIRFIEBRIB/E LI wererrrerersnessseressasssennasasacesssneses 50
3.4 DB BELE DoubleSpace ereereeene O )
3.4.1 LITE 4 A B22% DoubleSpace HEAETI{I] «vererererrereeneriosineiininiiienns 52
3.4.2 3% DoubleSpace EE}’JI{,& PP 3 |
3.5 DoubleSpace FEJE I «rereererorererersssrnesresrossssuesnorossoserassescnssseontansisnsss 64
TEZL B F{f ] DoubleSpace «reseeees seeermnnnranuiiitiitiiiiiiiiieiinieneececacinees 69
3.6.1 UN{AMfEBESL R ZEEET  coevveerererrrmrnmnmeiiiiiiiiiecctaie i seeseseeees 60
3.6.2 UIA[fE R RAELL T 7 ooreeroerseresesonomionasiiiisiitinmstinisisnscses 70
3.7 ﬁ;gﬁﬁgg&ﬂfumﬁp& reeerreerrerrransessesaescesanenenses 76
3.7.1 {354 DoubleSpace i FIBI FEAERS?  ceverrerereresssseraitiiesnss 76
3.7.2 ﬁuﬁﬂﬁuj DoubleSpace? P -]
3.7.4 tﬂﬁiﬂ%;{ﬁzmggﬁtm teernrereserresateenesseauneasnsnerresessaensnennsas 70
3.8 DoubleSpace BIZFIFRIE +revererreesersessserenssrersunsnessusssesesensuesesesesessasnsss 80
3.8.1 DBLSPACE 3C 2 il - vereeernenesnssassaresrsaneraness 8()
3.8.2 DBLSPACE &% Drive HhRETf§ F Bt WL 5741 - sreseseseenennes 8]
3.8.3 DBLSPACE #/¥ Compress HJRE R # FIRTHL G RAF]  <orevvceerereseveesee 89
3.8.4 DBLSPACE /¥ Tools THEEFH B BTHL G 7R -eoverererecsrasserannniies 9]
3.9 DoubleSpace 5§ QEMM-386 7. xx BL AW E R I +eveerverenrrerosanernceenenses 05
% 4 ¥ MemMaker RESHLE
4.1 MemMaker f IR SGHRAE  wveerreersornenseenssnemmnststonessneisetisessnnsnsisinnesss 96
4.1.1 MemMaker. EXE TR AL THFRF  cooverererrereronnsresennnreiennianes 06
4.1.2 MemMaker JFHR oceerereerrrrreesstasimieiiiiiiiiiiietiitsiniiiiiees §7
4.1.3 MemMaker BEVESEA] orveerorenrerseerserarsenesesnsietosssissiiisnenienniineses 98
4.1. 4 3FTF MemMaker JG REEJSBIELIPT  wereerresssnernroniinencnie 107
4.1.5 4% E MemMaker FFAIIBELT  +oreeremerrermerenncsnnnenccceieneee 107

.]Il



4.2

4.1.6 ﬁfﬁ MemMaker %fﬁiﬁ% eseseesrsaesassasecasess st areressaserearetrs o
ceer 111

4.1.7 tfil{f UMBs £ 1 32K?

MemMaker HITIR B BIERIE T IS coeerrrereerrrseraeniiiiiinianiniiian

4.2.1 MemMaker B(J Custom Setup ]ﬁIBj&f’E}}EHB P
+ 114

4.2.2 MemMaker Custom Setup 182k %35 1% B

#8 S SMARTDRV.EXE = REGFIERF

O 00 N O Y o W N

10
.11
.12
.13

01 (G2 | SJ“I s.ﬂ o Uy v oo oo Aan

SMARTDRV. EXE B4 B ZAFFRFreeeeeeeeeee

LR EBHERF SMARTDRV. EXE? correrreeeenrees
DOS 5. 0/6.0/6. 2 (] SMARTDRYV Z23E 75 coeeeerersrrreroraccreenninnes
DOS 6.0 5 6.2 B SMARTDRYV 37 IHRE (B EE v ceeorererssnssemrunenneiniiinnnnn
SMARTDRYV [ ZZ5E SHJIR +ovveeverrerrensersrerrssssssnasnsnsensssresssssnssasanssns
SMARTRDV §E A B EIETNEGFIEE wrreeererereensernnnrmicennesnsnnannnne

- 126

- 126
- 127

SMARTDRV 95;&5/3}?[2:]
£ /§ SMARTDRV. EXE #j£75 ‘3@1_%??%}%6}&3

SMARTRDV 3 o3 2 40l B A AEM R oo veevemeenemecomennimemcncene
SMARTRDV 7B ) BT 89 TL R AR B eervvever cremsnmnenessnneenens
SMARTRDV & FASTOPEN J BUFFERS «eecveeeree

F B SMARTDRYV fili CD-ROM #£ 5L -

% 6 M DEFRAG #BIEMRMKILIZRF

QOOO\)OE()'I#OJL\')»—I

DEFRAG. EXE BESLiEEELALTETT covverereverssnnemmeossmninininnnionieenen
FRAGMENTED W 5 DEFRAG F2FEHI R IR creereeeereoreensrarsreriiiaien
DEFRAG % F i) 21 (Recommendation ) {3 B «++ =« +secersseseranesseneonsraeeennns
DEFRAG AL 35 7 (Optimize) JAEE +oecorerereenereernerassnnenionntinsieenenses
DEFRAG 55 TR [H] -vv eeevvevssereurssors srnsseessnonassresnnesnesnsonssnsssnsanaes

DOS 6. 2 Xt DEFRAG 3 GE /Y 13

g7 i Anti-Virus B 5% B2 R 58

7.1

7.2

Anti-Virus PR GRBEAYTTIE reeerrreerrossersrersmranimsidtnsstiseseionneenea s
711 BRI G UL B v e ereoreore srenssanssnsvertes s sesseaaeannesaesre ere oes
7.1.2 Anti-Virus BFBE EREETREIT rrorrerrorrrerrerei sttt e neecnees

7.1.3 MSAV 5 VSafe X8| & 3
7.1.4 MSAV BIFEHEE S LB R E

7.1.5 VSafe K UFH TR EE G BH T cvoeeeerrrreacrtraniiiiininn

MSAV B FR SREH TTI: coerererenenen
7.2.1 MSAV.EXEW#HPAMSHBERET

110

112
112

+ 117
- 120
- 121

121
122
123
125

128

ceeeres 129
<129

131
132
134
137
138
142
142

-+ 143
- 144



7.

3

.2.4 T MSAV H# 5@E0

NN NN NN

VSafe 2R 5 LA -
VSafe RIFTEER E '3%%

NN N N N NN
W oW oW oW owow ow w
W 0 N O WL =W DN

7.3.10 e[ #E Windows P B| VSafe?

¥ 8¥ INTERLNK /MBYFISEH R F

® 0 9 00 0 0 0 0 P 0 ® ® w

8.

O© 0 ~N & O W NN -

= e e s
B W N e O

15

INTERLNK. EXE ;&&HM&%%&EF
INTERSVR. EXE W& R F8(BF -

ft 2.2 INTERLNK/INTERSVR? tteteeeessesosttasccrarsscttsornncsseacesconnenas
- 184
- 186
- 189
= 191
-+ 191

INTERLNK g4
INTERLNK { /i 324
INTERLNK &8 3 {43247
{45 % INTERLNK?
INTERLNK 5 fi £/ H7FE?

ik INTERLNK RAE BT, R FIEFET corereerecereercnricimniinee
A5 4 INTERLNK ) HTESEBEARHA]? revreerrersonsrssrnsnenninnnnnnes
INTERLNK FEBZFTHYJEE cereeereraressorensrionsarnionsarnnseranennsesnnisensas

ﬁﬁzgﬁ%ﬁ%ﬁgﬁmﬁﬁ%%%@ﬁgq R T T TR PP R T T PR
- 196

ey W 35 5% Il /B f£ 5 28 (CABLE) 2

(B 28 (CABLE) (B BIXTHEZE  ceevererrereserssenneontunraeesesrenanionssessnssnnses
¥ INTERLNK (£ B A BRIEHY PC wevvveveererorsorsusesssorisrsunesessesosnaesns

¥ 9¥ Multi-CONFIG S HEE

9.
9.
9.
9.

1
2
3
4

« IV o

472 % & 5 3) Multi-CONFIG?

Multi-CONFIG SEFRINE  cooerrerecrocnrincietietiiiieiieniinenes

Multi-AUTOEXEC S5 -

DEVICE? T:&%&%EEKJJ& FREBEREAN?

.2.3 MSAV RETNAE SIRIEREBET v,
S esssscsensesesstes st s s ssnsesnenses BEs 157

.2.5 MSAV (BTG E B FBEL cererrererreromncsnerionioie o,
. 2.6 MSAV B35 IR E (Options) AT cevvercercrrntiiiciniimieicenanee
.2.7 MSAV BERREER IR B Z RS  veoreerenrorsrrorensenenneressueenenesions
VSafe PRI ISR BRI (B BEDTRLIE  vovvereorornserorenmerrenneresenssenannansnns

7.3.1 VSAFE.COM mﬁﬁgﬂ;ﬁﬁﬁwﬁr
ve0sesrese vt etrtssesenen et snanns 165

153
156

159
160
163
164
164

eesesssssssanssacrsancanarscsscsscaress 1G7
mmmv&&gﬁ?mmmmmmmmmmmmmmmmm"mm
VSafe M BE GBI SLIEHED crovervrrerrrreeessrermrrmsesissessenesssssensneres
VSafe BYB4E(S BB L ISHDTHFT T oreverrrrrecrranissnessrenencrenenane
AT 4 VSafe 5 B I FFrerovevererrreerssersresssnnsaesssssessesssenesns
VSafe S5 HSCIFHERT?  corvererrensenrsrnnseversrererananemsnesesssnsesens

R VSafe 55 PE2 BIREEMIZE creoverermmminitiiiiiiinisi i eeeens
ee 178

169
169

e 170

171
174
176

-+ 180
- 182

183

192
193
193
194

196
197

«» 200
«+ 200
=+ 203
== 205



9.5
9.6
9.7
9.8
9.9
L BUE
10.
10.
10.
10.
10.
10.
10.
10.
10.
10.
10.
10.
10.

11.
11.
11.
11.
11.
11.
11.
11.
11.

© 0 N U s W DN

—
N = O

13

wm\lmmpw(\).—

YNl 2R IR B S R FEHLAY R A 2

Bkt CONFIG. SYS 5 AUTOEXEC. BAT HIEJE Bl seeeeeerereerssrusssnnicienn
:@ﬁﬁﬁi’ CONFIG. SYS B/Jp\]fév.& AUTOEXEC. BAT cccceccerccacscccscccccncse

Multi-CONFIG #4836 2158 55

MSBACKUP XX #4&#

MSBACKUP. EXE 28 5 0B TR wreerreeeeorseorsnensrsresananinne

AR MSBACKUP 5 214 ST B 38 2

K FT MSBACKUP

MSBACKUP & & 3¢ {4 345 —
MSBACKUP & & 3C {4 s 4 —

m{ﬁj‘i&??ﬁ%%ﬁ}? L T PN

M &g B

CATALOG FILE fJFR veveeeercrsnvrnrerssssnsenenes

SETUP FILE H‘Jﬁfﬁﬁ:\‘m tesesssssane
S 11 ¥ ScanDisk RIS SHEE
SCANDISK. EXE # &2 B REF

ScanDisk B F 3 5 & F AL
ScanDisk 18 f 3£ —

ScanDisk i Fi 3£ —

ScanDisk i 25 s 45 # £ 15 F L5
ScanDisk & & 324

e & ScanDisk #4157
ScanDisk B 2%V H

ScanDisk. INT # F iR 1/ B -

#£ 128 Windows LBIEFRE 'ﬁﬁﬁﬁ

12.

12.

12.

1

2

3

Windows 3£ ¥ AR S &3

12.1.1 DOS 6. x B"] Windows %mﬁ? esesssensesesesnssasencenes
12.1.2 Setup ZERRFEHYZ BT cocvererrerenresiortiontintiirmrannnieenenn,
12.1.3 {423 DOS 6. x # Windows SCFFRF wevverereervrrorereisiisnnnn

Anti-Virus for Windows

12.2.1 Anti-Virus for Windows FJ{ff Fj 326 ---ceeeeeet

12.2.2 Anti-Virus HEARARE 2
MSBACKURP fOr Windows «seeesestssssssetsseseransancecssacessensesenssssseenssssns

e

« 206
206
207
+ 208
212

214
- 214
215
- 216
-+ 220
220
e 226
- 229
234
cees 235
- 235
+ 236
.+ 237

- 240
- 242
- 243
+ 246
-+ 248
- 253
.« 257
+ 259
+ 261

cree 264

.+ 264
264
265
-+ 270
- 270
- 272
273



12.

4

12.3.1 MSBACKUP Bl i 5 AR AR +oveeeersvenserassesesssnsrsessseens
12.3.2 MSBACKUP for Windows B8 {58 B SEAR evevvevenreraneeenss
12.3.3 MSBACKUP for Windows B4Rk G E 2] «oreeeeereensersesseurees
Undelete for Windows eesersesesessestcaseseitistiriisorsiatcsccsotstosiicassacsanccs
12.4.1 Undelete for Windows ({8 I SE] «eeeerserersesesreseneruasaserseses

$ 138 DOS 6. x HFueHS

13.
13,
13.
13.
13.
13.
13.
13,
13.
13,
13.
13.
13.

W 00 NN O U e W

— s e
WO = O

CHOICE. COM 8  FE ] BE LA AT ST (BT woveeereerememmesmennsenssunsns
DELTREE ¥ H 5 B 30— SRR v vev erversveremrmssrsssns tonnssusssinnssunnas
DEVICEHIGH #1% & IR E1 R FESE A UMBSs ereeseerseresssnssosessaseeesesseeens
EMMS386. EXE " 75 PUAZ S BHARE cvevveveeoreneasensosstnntsenissisninsaneionees
cee 302

HIMEM. SYS ¥ B N & BT

LOADHIGH (LH) ¥ F2 4 A\ UMBs t++ee eeeserenesntiusiinintion e snassansnnens
<eee 306
MSCDEX. EXE H i3 (CD-ROM) IR BAFRTF soeceeereeervescrssecniacannieen.

MEM. EXE ML £ N 7/ 7

273

== 279
- 284

288
288

293
296
297
298

305

307
308
310
315
317

sese 320



#1E DOS 6. 2 FEIEENE

1.1 DOS i3

B WA ANRBPOLRERA DOS (HEBRIERL) , HILRITAT LIS “DOS &F H
87, BATA T RFRH DOS Al FEFE TR

DOS Ji & pg) CPU w9

1.0 1981 8088 FF R DOS (BLE & A 160K) (PC)
1.25 1982 XEFRE AR 320K
2.0 1983 IR R FH R WERE 5 360K (PC XT)
2.01 1983 REERFTS
2.11 1983 : HE 2. 01 fRAY45iR
2.25 1983 RIET FEFERR
3.0 198¢ 80286 3FE 1. 2MB & (PC AT)
3.1 1984 SCH PC W%
3.2 1986 SAC MR ME: Y
3.3 1987 80386 | % IBM PS/2 &5
4.0 1988 REIRE RS I
4.01 1988 I 4. 0 KR HAEIR
5.0 1991 80486 WS HEEREARTF
6.0 1993 REEHUZAR FRSTE.ERE
6.2 1993 WG AR RATMEE

1€L5) | ‘

(1) 1981 4 IBM PC #t i B, IBM 23 &) Z 45 Microsoft (5 A T F X & IBM #§ PC-
DOS % IBM PC 1§ fi , Microsoft ) MS-DOS M2 t%4 5 IBM PC AR YL FER, — &

DI RE KRS M F], ML B A9 2 4 AT 160K, 1982 4E 4 T 1B WIHE 320K M K, XHEH
. 1 .



DOS 1. 25,

(2) BE% DOS & B ERIE A SRS RE R B . DOS A W AT HE S 3, & —
A DOS WA R E &R H T ERA RS (ERS) RKERA &S @R 5 Frigs. Flm.
DOS 6. 2 W £ SR 6, BlRE W H 2.

(3) DOS B9 H RRA 4 5 B T 5 IR R E «

(a) IME FURARTE e I RE SO — SR W RE BRI S . f1n.DOS 3.0 7

K31, BT 4.0 BT 4. 01 W R VB B IE .

(b) 3 397 W A i T B R B e, M B B MRS 2, DOS 5. 0 $2 7+ / DOS 6. 0. £ &
BEEmARN T (EREE AR A ERHFEEIEE.
: (4) 1982 5K T X B AE & K, #ici: & DOS 2. 0, JLEH % H 5 XUE 360KB, 31 7] 32 1R

FHROIREE . ,

(5) 1984 4E IBM AT mfigisE A T DOS 3.0, JEE AT XML L H#EH DOS 3.
1.

(6) 1986 FEF- B BOERT AT, N T KB HETEZE S48 0 & L iR E
T4, B4 3.5 Fit & A, A DOS 3. 2,

(7) 1987 4 IBM PS/2 s fiiffE i . DOS 3.3 B 5 Z B & .

(8) 1988 LEHEH DOS 4. 0, B F E R R AEH Y DOS Shell, & 4 # FHE A HZRT
32MB,

(9) 1991 44 DOS 5. 0 B hN7F i 35 8 G B w58 9 I8 % L 5 4n UNDELETE,
UNFORMAT.DOSKEY, ‘

(10) 1993 4F 4 H 3 DOS 6. 0 BN L IEE Flin . R A (EHHA AR 7718
WA & D EENE EBEAS.

(11) 1993 4 11 AR DOS 6.2 XAt . R EFEMEHW R A T A A BRUEET R
DBLSPACE & 8 i 48 04 5 F2 7% SCANDISK f#H#E RF E M £ &,

¥ 1993 4E 6 H IBM A& # it PC-DOS 6. 1,

1.2 DOS 6. 0 fIPiEhte

%4 F DOS 6. 0 el i, & TH] LA B4 35 52 DOS.DOS £l L7 X & i U109 75
. WEMREHEK. SR I R , Microsoft 8 T35 Z Pk, JF IR R KA ThRER
(6] 55 0 1 BT (9 1B 42 BR 1000 J7 LA Lty DOS {§ F FH&aEE". DOS 6. 0 Fri¥ ey EEINGE
mr:

(1) {538 {37 B (DBLSPACE)

DOS 6. 0 5% K 5 R BE A% N 1% 14809 B £ 1765 %5 [A] (Double Space) » 1 i %3 Bl it i 48
BARESHENAR. LERFLEKRAR 1.8 1 IREIFEHA 100MB i £ 7] 4%7F 180MB
By SCERE . U5 B DIR/C S M2 4% S HY 4 1L

(2> Bk 72 (MemMaker)

DOS 6.0 ML T & 2 31438 HIMEM. SYS & EMM386. EXE, A] LL 3 AL & EMS &

- 2 .



XMS Z4b, X Frig—1 & B s il B B84y MEMMAKER. E£H 38 % CON-
FIG. SYS % AUTOEXEC.BAT, R EEMNE . SR HHERFAENBRFBE Linfriges
(UMBs), ff X 74535 A B KB Z R W ERATTE X MR X KAEFHEE .. B DOS
6.0 R EELBEANL. WEWMARE, _

(3) %% K % (Anti-Virus; MSAV VSAFE) .

 DOS 6. 0 #24LH EE B R F 5% DOS K& Windows iR 4 (MSAV X MWAV), 3 H

RUE PR F BT VASFE ARG IR EE A,

(4) BRMZ 6 5%E (MSBACKUP)

&M BF A4 H7E DOS T (MSBACKUP) & Windows F (MWBACKUP) #4147 , 7] 7 {#
T AR AR A A B M E R A0 TR RN MR EREAEH TR,
A FEE LRSS, AV REFE, EHEF AR ek,

(5) E# & (DEFRAG)

FERE S N SO H R E BT HER 8 2 FERE X PN % SE T A T4 S8R ey A B E , T ik
FHRERXGZ. VRS K/, BEREER.

(6) ZEFFHLiE (MULTICONFIG)
- fEFFHLET, % % T [F5) A B A a4 DOS i, A #[F8], % CONFIG. SYS py%
kRGBS 4 CHOICE , 8 S AT SATH SCHRT 25 5 #1732 5 iy ik
%,

(7) 3C{41&% INTERLNK % INTERSVR)

AR P A LA SR AT S 0 O AT 0 1 S R A R S 1 O 1 e, LA LR R R R AT
Bl &

(8) Mk H #* KX (DELTREE)

A RRMBR A€ B R T 8T A S R H %, —4 DELTREE fy 4 A LB HITIF B K
# DEL % RD,

(9 Bah X BB K% (MOVE)

M H MOVE @& o] IR E CHES TFHRZ M, TUREER 42,1
AERFEHREERK. ~

(10) HAbThEE

DOS 6. 0 FHIK B {5 B 64 FASTHELP; i i) 4 #2.#2/F POWER ;; CD-ROM (1) 3% 3
#F MSCDEX; LA K 3838 D) REHY) SMARTDRV -+ 82 E L A B9, S0 S E [ 14

B2, DOS 6. 0 HFHEThEE, &1 7T 98 B B9 F 4 Microsoft %t DOS 1% AE By “ &
BL7“BHER”, ] MS-DOS OA 81 R4, B9 B 2 B B i 5,

1.3 DOS 6. 2 W ke

J} 404 MS-DOS 6. 27
H WA MS-DOS 5. 0 f| FAES T » 2K (Microsoft ) B A B IREF £ FRAY MR A, 3
F 1993 4 A iy B DOS 6. 0, B P EMRFEHE TELHEAE, ERHEZRUH
. 3 .



BE,

Wit i F MS-DOS 6. 0 #) DoubleSpace ({53818 A B ) IEEH Fik 62%, Ek
W25 2 {8 A& #9 @1, X DoubleSpace #J &3 R . ELFEMT KIBK R, % TF 1993
g4 F XHEE DOS 6. 2 [T,

Ktz 6. 2 Wer MAKR/NMIERE TIHREN B E, K # H MS-DOS 6.0,1BM
fEHE 1 PC-DOS 6. 1(£ T 0. 1), Fr LXK B 6. 2 BBURAALS .

MS-DOS 6. 2 ¥ ThEesEE Ptk

MS-DOS 6.2 HESA . — KN IGRE &, A ERE. TR S .
(FEXL2FEEIE]

(1) i ScanDisk G #i B £ TR #2F, # B DoubleSpace ZHTEE ¥ M #ER L.

(2) DoubleSpace 3 fill DoubleGuard ZhfE , $2 4t /= 25 Al {37, 8 S BUHE 2 1.

(3) HIMEM. SYS H #hta & PC By TR 488 IR BUR T IR .

(4) FHFF (SETUP) £5)i% E SMARTDRV H{# f i A BHE (read cache),

(5) 4 MOVE ,COPY . XCOPY £ £ 31 #IWf B i3 2 & F M & Wy it .
(EESERSEIHE]

(1) DoubleSpace il A H Z1#K & (/UNCOMPRESS) #J ThEE ,

(2) DoubleSpace B8 B 3 ¥ 45 b9 & fr , BBV o] B84 F . A 0B MOUNT,

(3) SMARTDRYV 3% % CD-ROM # & 3 B 7F (cache) BE 7,

(4) [Fa|& 4R AT 3£ 4 AUTOEXEC. BAT & T @14 M HIT 5 &,

(5) Hi#[Crrl] 4 [F5|#42, BE45 7% A DoubleSpace H #FFHL .

(6) DISKCOPY RS F R AR MR E I —RER . A LEHBRE .

(7) DEFRAG A] AR F] XMS Memory (" R fEE 8% ) . (F HAEAL IR KA B K F £ 3 (F
HITE R,

(8) DIR\.MEM ,CHKDSK 4 FORMAT #14 1 & 7 870, G F (08 o _Eig i .
[HELP (#7358 That S AfiH ] |

I R I HIRE, Ry E W ik HELP 42 (0 F he 5 B, 242 % DOS 6. 2
ZIE A

C = \>>\help whatsnew (<21

R STi AT HELP M4

C : \>\help

AT 5 B



-

File Search He lp
MS-DOS Help: Command Reference

Use the scroll bars to see more commands. Or, press the PAGE DOWN key. For ﬂ
more information about using MS-DOS Help, choose How to Use MS-DOS Help
from the Help menu, or press F1. To exit MS-DOS Help, press ALI, F, X.
(What’s New in MS-DOS 6.27>
CANSI.SYS> <Erase> - (Nlsfunc>
<Append> <Exit) <Numlock>
<Attrib> <Expand> <Path>
CBatch commands> CFasthelp> {Pause>
(Break> {Fastopen> {Power>
(Buffers’ (Fc> CPOWER .EXE>
Call> <FcbsX¢ <Print>
<Ca> <Fdisk> {Prompt>
{Chcp> <Files)> (Qbasic)
{Chdir> (Find> <RAMDRIVE.SYS>
<Chkdsk> ! <For> <Rd>
(CHKSTATE.SYS)> {Format> (Ren>
Choice> {Goto> {Ren>
<Cls> {Graphics) {Renawme>
(Command> CHelp> ’ CReplace)

{Alt+C=Contents) (Alt+eN=Next) <Alt+B:=Back)

N 80606 1882

)

| BB <what's New in MS-DOS 6. 27 > H /[ FF 47 2.1 (8 e o8, 4T EDBLATED

Vs

-

File Search - Help
MS-DOS Help: What's New in MS-DOS 6.27

What’s New in MS-DOS 6.27

Welcome to Microsoft MS-DOS, the most widely used operating system for
personal computers. MS-DOS 6.2 improves on the safety and ease of use
provided by MS-DOS 6. The rest of this topic describes features new to
MS-DOS 6.2. For information about features included in bath MS-DOS 6 and
MS-DOS 6.2, see the Welcome chapter of the MS-DOS 6 User’'s Guide.

Safety Features and Enhancements

MS-DOS 6.2 includes ScanDisk, a new utility that detects, diagnoses, and
repairs disk errors on uncompressed drives and DoubleSpace compressed
drives. ScanDisk can repair file system errors (such as crosslinks and
lost clusters) and physical disk errors. ScanDisk keeps a log of its
repairs and enables you to undo any of the changes it made. DoubleSpace
runs UcanDisk to check the reliability of your disk before it begins
compression. You can also run ScanDisk yourself by typing SCANDISK at the
commanrd prompt. For more information, see (An Introduction to ScanDisk).

C(Alt+C=Contents> (RlteN-Nexb> C(Alt+B=Back> N Bd621:847

—~




[MS-DOS 6. 2 Fritdal f&a R THEE]

% b lg I 3
HIMEM. SYS g F 3k PC MBI E.
SMARTDRV. EXE Bk MEMRXHAHBESEAER]EASEMR DOSFEHC: \>)
' Frig AR BEENTEEF .
OPY, XCOPY,
1(\:/IOVE B WM EBME B SCERT, AfEER S BT e E.
DISKCOPY B EAAES S EX . ARAMR GRS ENAR — KT/,
ScanDisk i PR NHERESHREES.
DEFRAG. EXE & BEFRT BEESXMS)  BEE KW,
DIR, MEM, CHKD- _ . . .
SK..FORMATE &K BEBRAX BTAENEE S E T ERE.
i g | [FY|@ & —i## AUTOEXEC. BAT @4 B & #f7.
IR .
g +ﬂ$%)\ DoubleSpace H# 41 .

¥ ScanDisk 2y DOS 6.2 £ FH I w45 .

1.4 DOS 6. 2 FiiHThakia HLH

1.4.1 k885

DOS 6.2 TEAEEES 7, %4 & A4 HIMEM. SYS W38 7 2h 86, £ £3 4 PC Tk
SO, BT ATV E R 2 T —17:

HIMEM is testing extended memory. . .

M CPU Wy B RS A ', 7 —/NEBSES » (8 1 Bl “done”

HIMEM is testing extended memory. . . done.

done KR MHA 72 5, I H A8, XTI E BRI PC [ L2, AR —%
HIHE L, IR FFPLER B % — 4 )L, fl#n 16MB B 32MB, {(B7E X FE L F . & 1842 1E HIMEM.
SYS BEFTIX MR , 7T LA #E CONFIG. SYS R4 AL & LA L5

DEVICE=C : \DOS\HIMEM. SYS /TESTMEM : OFF

REERA S BHFEESNK T 2 F 2 LR LU U] LAl £/ TESTMEM : OFF

ﬁﬁo

1.4.2 HERERZEERD

DOS WyZe 32 F (SETUP) R PC BE#5 {8 B SMARTDRYV B, @4 £31# AUTOEX-

L)



EC.BAT A :
C : \DOS\SMARTDRV. EXE /X

/X EDOS 6.2 FHMBY, FEAMERE, ERLARABRENSARERH
(write cache) B 1, {H R X b £ e K R B AR RL2E .

¥z MR, B BB NEHERE, EXHFFEAN,SMARTDRV 2EFARERFX,
BAVBAGER, RBARL 8 HEHRENE, R B MR 7 AR X8 35 R AT 6K A
B FE SO A B B R ' _

AL HEHL,6. 2 B E I, SMARTDRY & 723K {4 58 fr & 45 R BT, S X6 B A B
BABEE A A DOS RARFS. WREEAKTIR DOS 6. 0, WAFTHRET TS
XL

C>SMARTDRYV /C

/C BYRETRIE ’I%ik"-%’)\%ﬁﬁiﬂﬂ%)\mﬁ AR MR RHLAT 5 B IHFRMILFE X
H R RHITT ,

H—FHE B ,DOS 6. 2 B SMARTDRV ﬁtﬁia‘e‘f CD-ROM T, XE#SBEMH YT IEIL
B R B XMS Memory 434 SMART CD 8/ . 4 FIiHSE iE & , i ¥ MSCDEX IE3)
#J¥ 3 SMARTDRV 2 i, ik SMARTDRV %1i§# CD-ROM F¢4E, 6140 ;

BRiIZFRRE:

C = \DOS SMARTDRV. EXE
C + \DOS\MSCDEX /D : SONY 001 (B-F CD-ROM B L 8)

BREMIRE.
C : \DOS\MSCDEX /D : SONY001 (5c%-F CD-ROM &t 5)
C : \DOS\SMARTDRV. EXE (SMARTDRYV 3+ CD-ROM = 2%)

M AR B A F 1789 CD-ROM CACHE ¥, 1 7 ik SMARTDRV # &% A CD-
ROM REERF, HFMA S .

C : \DOS\SMARTDRV. EXE /U

1.4.3 XHHENSBS

# I (COPY) 4 LR PC M 2 MBI A4, A I SR £ 1 L8918 ST AR T3
A5 R AR 3 32 T (Overwrite)  SEAE AR A IR » B S50 50 R AR MR 80 1 97 S 1 64
$04%, 4 T % S, 45 T & MOVE,COPY. XCOPY 74 5 H o8 876 # I X ff & 1

HEBERBA—T, .

C : \>>copy ¢ : \dos\himem. sys a 3 (# 1 HIMEM. SYS)
C : \>copy c ¢ \dos\himem. sys a : (F COPY —REH)
Overwrite C + HIMEM. SYS (Yes/No/All)?




AT BT
(1) “Yes"J:t) B 4% I IR B FRET SO & 182D

(2) “No” A LA 3

(3) “AI"ARE N+, A HRAX L EEERE %, ALEW,
BIRERRIE , Y| RN K (A)E . Bk,
WRFECHLH X HEAMAFEERE RN, T L/Y S5, 6140

TC + \>>copy ¢ : \dos\himem. sys /y (A %la), HiE COPY)
BB E BIT/Y KRBT, W # AUTOEXEC. BAT AR E
i SET COPYCMD=/Y
RXEEE A2 B RAA A, o] 207 — et AR A X T ThEE Ry W& B2 ER/-Y 8B+,
REFmT .
C : \>>set copycmd=/y (& COPY RAE&(a])
C : \>>copy ¢ : \dos\himem. sys GRAE.BREHD

C ¢+ \>>copy c : \dos\himem. sys /y (Bl —KIE 1)
Overwrite C : HIMEM. SYS (yes/NO/Al? (RRXELHIN

1.4.4 BHZENERY

HA—& FLOPPY Bk IR 2 8) 5 1. 2MB 5 1. 44MB & &4 W AE & T ,MS-DOS
6. 2 fJ DISKCOPY W) — R R # I, A H = F#H WS T SOURCE(RE& F) R —iK,
TARGET(HHI & ) X & —%.
##y DISKCOPY 54 8 B 3h # F 18 £ 77.6% SOURCE, fif ML — ik fE B8 %252, T EL IR tm [4]
—3¢ SOURCE 7] h#% 01 £ #if TARGET, & £ & & SOURCE, iX o # % #7 tt PCTOOLS —
5 EER R

C + \DOS>diskcopy a ¢ a*

Insert SOURCE diskette in drive A : (GRABE SRR
Press any key to continue. . . (FAE — 8T RIERO '
Copying 80 tracks. 15 sectors per track. 2 side(s) (1. 2MB W& )
Reading from source diskette. . . CHAFNARIEABER
Insert TARGET diskette in drive A : RABEIHR A
Press any key to continue. . . RAEFT T S T
Writing to target diskette. . . (EA&R)

Dl —5K 1. 2MB W F KR ALTEFRE RS F . T BB I EE B 280 .

Do you wish to write another duplicate of this disk (Y/N)?

(AR B R R — K R gD
i 7] — 3¢ SOURCE 4% UL s B (7 s 0F £ L i 1 Y] tH (5 B T
o R

i
|
|




